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Overview 

The Ethernet communication module serves as the interface between a M340 PLC 
and other Ethernet network devices by means of either the EtherNet/IP or the 
Modbus TCP communication protocol. This chapter shows you how to install the 
module by:

inserting it into a PLC backplane
connecting it to an Ethernet network
installing the Unity Pro Ethernet Configuration Tool software

What’s in this Chapter?

This chapter contains the following topics:

Topic Page

Physical Description of the BMX NOC 0401 Module 14

Module Specifications 17

Communication Specifications 19

Mounting the BMX NOC 0401 Module 21

Installing Unity Pro Ethernet Configuration Tool Software 23

UnInstalling the Ethernet Configuration Tool 25
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Physical Description of the BMX NOC 0401 Module

Front

The front of the module presents the following features:
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Rotary Switches

The back of the BMX NOC 0401 presents two rotary switches, which you can use to 
specify how the module will obtain its IP address. 

The settings of these two rotary switches work together to specify the source of the 
module’s IP address, as follows:

Setting Description

Upper switch:

0...9 Tens value (0, 10, 20...90) for the device name setting. It is added to the ones 
value on the lower switch to identify the module to a DHCP server.

A...F Tens value (100, 200, 300...150) for the device name setting. It is added to the 
ones value on the lower switch to identify the module to a DHCP server.

Lower switch:

0...9 Ones value (0, 1, 2...9) for the device name setting. It is added to the tens 
value on the upper switch to identify the module to a DHCP server.

A + B BootP1:The module obtains its IP address from a BootP server.

C + D Stored1: The module uses the IP address configured in the application.

E + F Clear IP1: The module applies its default IP address. 

1. The lower switch alone determines module behavior. The upper switch is ignored.
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Switch Labels

The right side of the module displays two labels explaining the choice of rotary 
switch settings, as depicted below.

LEDs

The BMX NOC 0401 communication module presents the following LED indicators:

RUN (running)
ERR (error)
MS (module status)
NS (network status)
ETH STS (Ethernet status)

In addition, each Ethernet port presents the following two LED indicators:
LNK (link)
ACT (activity)

For a description of these LEDs, and how to use them to diagnose the 
communication module, refer to the topic LED Indicators for the Ethernet 
Communication Module (see page 292).
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Module Specifications

Specifications

BMX NOC 0401 specifications include:

Software Compatibility

The Ethernet communication module is compatible with Unity Pro programming 
software version 5.0 and higher.

Standards

The Ethernet communication module complies with the following standards: 
UL 508
CSA 22.2-142
CSA 22.2-213
CE
EMI EN55011
EN61131-2
IEC61131-2
IEEE 802.3 2002
ODVA

Ports

Communication Ports Four auto-sensing 10/100Base-T shielded twisted pair (RJ-45 
connector) ports. 

Electrical

Bus Current Required @3.3V: 550 mA

Power Dissipation 1.9 W

Fuse None

Operating Conditions

Temperature –25...+70° C

Humidity 0...95% Rh non-condensing @ 60° C

Altitude 2000 m (6561.68 ft)

Storage Conditions

Temperature –40...+85° C

Humidity 0...95% Rh non-condensing @ 60° C

Altitude 3000 m (9842.52 ft) transport
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Communication Modules per Station

The maximum number of communication modules—including but not limited to 
BMX NOC 0401 Ethernet communication modules—you can install in a single 
station is determined by the CPU serving that station

CPU Maximum Number of Communication Modules per Station

BMX P34 1000 1

BMX P34 2000 2

BMX P34 2010 2

BMX P34 20102 2

BMX P34 2020 2

BMX P34 2030 2

BMX P34 20302 2
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Communication Specifications

Introduction

The following specifications describe both the I/O communication and the 
explicit messaging capacities of the BMX NOC 0401.

I/O Communication Specifications

The Ethernet communication module presents the following I/O communication 
features:

Communication type Feature Capacity

EtherNet/IP 
(CIP Implicit Messaging)

Scanner

Maximum number of devices 128 devices (125 devices as scanner + 3 devices 
as adapter) shared with Modbus TCP

Maximum message size 512 bytes

Adapter

Maximum number of instances 3 adapter instances

Maximum number of connections 2 connections per instance

Maximum message size 512 bytes including header

Inputs 507 bytes excluding header

Outputs 509 bytes excluding header

Modbus TCP 
(Modbus Scanner)

Maximum number of registers

Read 125 registers

Write 120 registers

Maximum number of devices 128 devices shared with EtherNet/IP

Maximum message size

Read 250 bytes (125 words) excluding header

Write 240 bytes (120 words) excluding header



Installation

20 S1A34009 07/2011

Explicit Messaging Specifications

The Ethernet communication module presents the following explicit messaging 
features:

Communication type Feature Capacity

EtherNet/IP 
(CIP Implicit Messaging)

Client

Maximum number of simultaneous 
connections

16 connections

Maximum number of concurrent 
requests

16 requests, shared with Modbus TCP

Server

Maximum number of simultaneous 
connections

32 connections

Maximum messaging size 1023 bytes

Modbus TCP 
(Modbus Scanner)

Client

Maximum number of simultaneous 
connections

16 connections

Maximum number of concurrent 
requests

16 requests, shared with EtherNet/IP

Server

Maximum number of simultaneous 
requests 

128 requests

Maximum number of simultaneous 
connections

32 connections

Maximum message size

Read 250 bytes (125 words) excluding header

Write 240 bytes (120 words) excluding header
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Mounting the BMX NOC 0401 Module

Tools Required

One medium sized (size 2) Phillips-head screw driver.

Mounting the Module

The module can be mounted in any of the racks of the Modicon M340 system. It can 
be installed in any available slot (except in the offset X Bus racks). To mount the 
communication module:

Step Action Illustration

1 Position the locating pins (situated at 
the bottom part of the rear of the 
module) in the corresponding slots. 

2 Swivel the module upwards toward 
the top of the rack, so that the back of 
the module sits flush with the rack.
NOTE: Before positioning the pins, be 
sure to remove the pins protective 
cover.

3 Tighten the screw to hold the module 
in place on the rack.
NOTE: The tightening torque is 
1.5 N.m
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Wiring

The Ethernet communication module communicates over an industrial Ethernet 
network through any one of four RJ45 connectors located on the front of the module.

Use the top two ports (ports 1 and 2) to connect to end devices.
Use the bottom two ports (ports 3 and 4)—which support the RSTP redundancy 
protocol—to connect to the local area networks, for example, a ring.

WARNING
HAZARD OF ELECTRICAL SHOCK OR BURN

Connect the ground wire to the protective earth (PE) terminal before you establish 
any further connections. When you remove connections, disconnect the ground 
wire last. The Ethernet cable shield must be connected to PE ground at the 
Ethernet switch.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Installing Unity Pro Ethernet Configuration Tool Software

Software Installation

The Unity Pro Ethernet Configuration Tool software is included on the installation 
disk that ships with your new Ethernet communication module. To install this 
software, just place this disk into your PC’s CD or DVD drive. The setup process 
starts automatically.

NOTE: If you need to manually initiate the setup process, navigate to the root of the 
installation CD and run the file Setup.exe.

The setup process displays the following setup screens:

Step Screen Description

1 Welcome Click Next to continue.

2 ReadMe and 
Release Notes Display

Indicate whether to display the ReadMe file.
Click Next to continue.

3 ReadMe (Optional) Displays the ReadMe file, if selected above.
Click Next to continue.

4 License Agreement Displays the software license.
Select I accept..., then click Next to continue.

5 Customer Information Enter the following data:
your first and last names
company name
identify for whom the software is installed:

anyone who uses this computer
only for yourself

Click Next to continue.

6 Destination Folder Identify where the application will be installed. Either:
Accept the default path
Click Change... and specify a new path

Click Next to continue.

7 Ready to Install Click Next to continue.

8 Status Progress bar indicates the status of the installation.
When complete, click Next to continue.

9 Install Complete Click Finish.
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Updating Hardware Catalog

When you run the software installation program, the following objects are installed 
on your PC:

the Unity Pro Ethernet Configuration Tool
a Generic EtherNet/IP DTM
a Generic Modbus TCP DTM

NOTE: A DTM is a small software driver that defines and enables a device.

The next step is to refresh the Hardware Catalog. Refer to the topic Updating the 
Unity Pro Hardware Catalog (see page 113) for step-by-step instructions.

Updating the Hardware Catalog adds your new Ethernet communication module to 
the list of available modules and devices that you can add to your Unity Pro 
application.
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UnInstalling the Ethernet Configuration Tool

Introduction

Use the Add or Remove Programs utility provided by the Windows&#63722; 
operating system to uninstall the Unity Pro Ethernet Configuration Tool.

To completely uninstall the Ethernet Configuration Tool, you must remove each of 
the following three DTMs, one at a time:

Un-Installing Ethernet Configuration Tool DTMs

To remove the three Ethernet Configuration Tool DTMs:

Step Action

1 Open the Windows Control Panel: Start → Settings → Control Panel.

2 In the Control Panel, double click on Add or Remove Programs. 

3 In the Add or Remove Programs window, select the 
Change or Remove Programs page. 

4 Select the first of the three DTMs to remove (for example, the 
Generic EtherNet/IP DTM), then click Remove.

5 Repeat step 4 for each of the remaining 2 DTMs: Generic Modbus DTM and 
Unity Pro Ethernet Configuration Tool. 
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Configuring the Ethernet 
Communication Module

Overview

This chapter shows you how to use Unity Pro programming software to select and 
configure the Ethernet communication module.

NOTE: The instructions presented in this chapter include specific choices made for 
a sample project. Your Unity Pro project may include different choices that are 
appropriate for your specific configuration.

What’s in this Chapter?

This chapter contains the following sections:

Section Topic Page

2.1 Ethernet Network Configuration Example 28

2.2 Creating a Project in Unity Pro 30

2.3 The Unity Pro FDT/DTM Interface 39

2.4 Channel Properties 58

2.5 Ethernet Services 73

2.6 Configuring the Ethernet Communication Module as an 
EtherNet/IP Adapter

92
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2.1 Ethernet Network Configuration Example

The Ethernet Network Example

The Ethernet Network

This manual describes the creation of a complete Ethernet network configuration for 
the following topology:

1 Primary PLC incorporating the BMX NOC 0401 Ethernet communication module 
2 A secondary PLC that “listens” to the scan of the primary PLC local slave by the third-party 

scanner 
3 Ethernet managed switch
4 Advantys STB island, with an STB NIC 2212 EtherNet/IP network interface module plus 8 

I/O modules
5 Advantys STB island, with an STB NIP 2212 Modbus TCP network interface module plus 

8 I/O modules
6 Third-party PLC that scans a local slave in the primary PLC (1)
7 PC equipped with both Unity Pro configuration software (upgraded with the Ethernet 

Configuration Tool that ships with the BMX NOC 0401 Ethernet communication module) 
and Advantys configuration software, used to configure communication settings for 
Ethernet communication module in the primary PLC (1) and the remote network interface 
modules on the STB I/O islands (4 and 5)
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Multiple Roles of the PLC and Ethernet Communication Module

The PLC, and in particular the BMX NOC 0401 Ethernet communication module, 
can be configured to simultaneously perform multiple roles with respect to other 
network devices. In this sample network, you will learn how to configure the 
communication module to operate as:

a scanner of devices that use the EtherNet/IP (4) and the Modbus TCP (5) 
protocols
an adapter—also known as a local slave—that produces output data that both the 
remote third-party PLC (6) and secondary PLC (2) can read as input data
a DHCP server that provides IP address settings to other devices on the Ethernet 
network
an FDR server that provides operational settings to devices on the Ethernet 
network that also receive their IP address from the DHCP server, above 
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2.2 Creating a Project in Unity Pro

Overview

This section shows you how to add modules—including the BMX NOC 0401 
Ethernet communication module—to your project, using Unity Pro.

NOTE: For detailed information about how to use Unity Pro, refer to the online help 
and documentation DVD that come with Unity Pro.

What’s in this Section?

This section contains the following topics:

Topic Page

Creating a Project in Unity Pro 31

Configuring the Size and Location of Inputs and Outputs 36
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Creating a Project in Unity Pro

Introduction

This topic shows you how to create a new Unity Pro project, and add to the new 
project the following components:

a CPU
a power supply
a BMX NOC 0401 Ethernet communication module 

Creating and Saving a New Unity Pro Project

Use Unity Pro to create a new project. The following steps describe the creation of 
a project for the sample network:

Step Action

1 Open Unity Pro.

2 In the Unity Pro main menu, select File → New....
The New Project window opens displaying a list of Schneider-Electric controller 
types.

3 In the New Project window, expand the Modicon M340 node and select a CPU. 
In this example, select the BMX P34 2020 Modbus Ethernet controller:

4 Click OK. Unity Pro displays the Project Browser, below.
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5 To save the project, select File → Save. The Save As dialog opens. 

6 In the Save As dialog, type in a File name—which will be the name of your Unity 
Pro project—then click Save. Unity Pro saves your project to the specified path 
location.
NOTE: You can change the default location Unity Pro uses to store project files. 
Before saving your project:

1 Select Tools → Options. The Options Management window opens.
2 In the left pane, navigate to Options → General → Paths.
3 In the right pane, type in a new path location for the Project path. You can 

also edit the:
Import/Export file path
XVM path
Project settings templates path

4 Click OK close the window and save your path edits.

Step Action
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Adding a Power Supply to the New Unity Pro Project

When you added the CPU to the project, above, Unity Pro may also have added a 
power supply to the project. If not, the next step is to manually add a power supply 
to your Unity Pro project:

Step Action

7 In the Project Browser, double click 0 : PLC bus. Unity Pro displays both the:
Local Bus window with the selected CPU in the second position, and
Hardware catalog displaying the Local Bus tab, below:

8 In the Hardware catalog, under the Supply node, use your mouse to select then 
drag a BMX CPS 2000 power supply to the first position in the rack.

9 In the File menu, select Save, to save your edits.
NOTE: Schneider-Electric recommends that you periodically save your changes 
as you make edits.
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Adding an Ethernet Communication Module to the New Unity Pro Project

Next, add an Ethernet communication module to your project:

Step Action

10 Returning to the Hardware catalog, under the Communication node, use your 
mouse to select then drag a BMX NOC 0401 communication module to an open 
slot in the rack—in this example, slot 2. 
When you drop the communication module into the rack, Unity Pro opens the 
communication module Properties window.

11 In the General page of the module properties window, type in an alias name for 
the communication module: NOC01:

When you change the alias name, Unity Pro changes the base input and output 
type and variable names to match the edited alias name. 
NOTE: 

Schneider Electric recommends that you always assign a unique alias name 
to each communication module.This practice helps you distinguish between 
modules of the same type.
No other configuration needs to be—or can be—performed in the pages of 
this window. All other pages are read-only.

12 In the File menu, select Save, to save your edits.
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13 Click OK to close the Properties window. The Local Bus now displays the three 
modules you have added:

14 The next step is to configure the located memory space in the CPU for the 
communication module’s inputs and outputs (see page 36). 

Step Action
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Configuring the Size and Location of Inputs and Outputs

Overview

Use the Configuration page of the Ethernet communication module’s Properties 
window to configure:

the size and starting position of inputs 
the size and starting position of outputs

The following steps present one example of how to configure the size and location 
of inputs and outputs. Your own project configuration may differ.

Setting Input and Output Memory Addresses and Naming the Module

The Properties window opens when you double-click the left mouse button on the 
image of the BMX NOC 0401 communication module in either the Local Bus 
window, or the Project Browser.

When you select the Configuration page, it displays the network—or Alias—name. 
This is the name assigned to the network channel when the communication module 
was added to the project.

Use the Configuration page to edit the communication module inputs and outputs, 
as follows:
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To input the above settings, take the following steps:

Step Action

1 In the module’s Properties window, select the Configuration page.

2 Type in the size and starting position of the inputs and outputs, as follows:

In the Inputs area:
In the %MW index field, type in a starting address for inputs—in this example: 1.
In the Max size field, type in the maximum number of 16-bit words dedicated to 
inputs—in this example:100.

In the Outputs area:
In the %MW index field, type in a starting address for outputs—in this example: 
101.
In the Max size field, type in the maximum number of 16-bit words dedicated to 
outputs—in this example: 100.

Notes: 
The inputs and outputs must be located at the beginning of a 4-byte (or 2 word) 
range. Because address numbering in the M340 platform is zero-based, this 
means the %MW index input and output settings must always start at an even 
number. 
The space allocated to inputs and outputs must not overlap.
Unity Pro automatically reserves space for two arrays of 32 bytes, as follows:

for connection health bits (see page 179), located at the beginning of the space 
configured for inputs
for connection control bits (see page 182), located at the beginning of the 
space configured for outputs

The specified %MW range for both inputs and outputs must be available in the 
CPU. For more information, refer to the Unity Pro help file topic Processor 
Configuration Screen. 

3 In Unity Pro select Edit → Validate (or click the Validate  button) to save the 
address and size settings for inputs and outputs.
NOTE: After you validate module settings for the first time, the module name cannot 
be edited. If you subsequently decide to change the module name, you must delete 
the existing module from the configuration, then add and rename a replacement 
module.
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Completing the Ethernet Network Configuration

After configuring settings for inputs and outputs, the next step is to configure the 
communication module settings—beginning with its Channel Properties—and then 
configure remote Ethernet network devices (see page 107).

NOTE: After you input configuration settings for the communication module and 
remote devices, return to the Configuration page of the Ethernet communication 
module’s Properties window and click the Update application button. This creates 
derived data type (DDT) variables (see page 174) that display the following 
information and commands for your Unity Pro project:

connection health bits, that display the status of each connection
connection control bits, you can use to toggle each connection on and off
the value of input and output items
module and device configuration settings
free memory space that has been reserved, but not yet allocated
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2.3 The Unity Pro FDT/DTM Interface

Overview

Unity Pro incorporates the Field Device Tool (FDT) / Device Type Manager (DTM) 
approach to integrating intelligent remote devices into your process control 
application. Unity Pro includes an FDT container that interfaces with the DTMs of 
EtherNet/IP and Modbus TCP devices.

A DTM is a collection of properties that define an EtherNet/IP or Modbus TCP 
device. Adding a device to your configuration means adding the device’s DTM to 
Unity Pro’s DTM Browser. From the DTM Browser you can open the 
Device Editor, which you can use to configure the parameters presented by the 
DTM.

Device manufacturers may provide a DTM for each of its EtherNet/IP or Modbus 
TCP devices. However, if you are using an EtherNet/IP or Modbus TCP device for 
which no DTM exists, you can configure the device by:

configuring a generic DTM provided in Unity Pro, or
importing the device’s EDS file—Unity Pro will populate DTM parameters based 
on the contents of the imported EDS file

What’s in this Section?

This section contains the following topics:

Topic Page

DTM Browser 40

DTM Browser Menu Commands 43

Field Bus Discovery Service 48

Device Editor 52

Configuring Properties in the Device Editor 54

Uploading and Downloading DTM-Based Applications 56
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DTM Browser

Overview

The DTM Browser displays a hierarchical list of DTMs—in the form of nodes on a 
connectivity tree—that have been added to your Unity Pro project. Each DTM node 
represents an actual module or device in your Ethernet network.

Node Types

There are 3 types of DTM nodes:
Communication DTMs:

Any COM DTM can be plugged directly under the root node (Host PC) and 
must be at the 1st level
A COM DTM can support Gateway DTMs or Device DTMs as children if their 
protocols are compatible

Gateway DTMs:
A Gateway DTM can support other Gateway DTMs or Device DTMs as 
children if their protocols are compatible.

Device DTMs:
A Device DTM does not support any child DTMs



Configuring

S1A34009 07/2011 41

Node Names

Each DTM has a default name when inserted into the browser. The default name 
consists of the following elements:

<Channel: Address> Device Name

Where:

Node Status

The DTM Browser displays the status of each DTM node in the connectivity tree, 
as follows:.

Element Description

channel This is the name of the channel communication media, to which the device 
is plugged in. This name is read from the DTM and is set by the device 
vendor.
Example: EtherNet/IP, Modbus

address The bus address of the device, which can be:
The connection point on its parent gateway network
The slot number in the modular device parent internal bus

Example: the device IP address

device name The default name is determined by the vendor in the device DTM, but can 
be edited by the user.

Status Description

Built / Not-built A blue check mark  superimposed on a device icon 
indicates that node, or one of its sub-nodes, is not built. This 
means that some property of the node has changed, and the 
information stored in the physical device is no longer 
consistent with the local project.

Connected / Disconnected A connected DTM is denoted in bold text. An unconnected 
DTM appears in plain text. 
NOTE: 

Connecting a DTM to its physical device automatically 
connects all higher level parent nodes up to the root node.
Disconnecting a DTM from its physical device 
automatically disconnects all its lower level child nodes.

NOTE: Connecting or disconnecting a DTM to or from its 
device does not also connect or disconnect Unity Pro to or 
from the PLC. DTMs can be connected/disconnected while 
Unity Pro is either offline or online.

Installed / Not-installed
A red  superimposed on a device icon indicates the DTM 

for that device is not installed on the PC.
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Handling Invalid Nodes

As indicated above, a red  superimposed on a node indicates the DTM for that 
node is not installed on the PC. To resolve this situation, click the right mouse button 
on the node to open a pop-up menu with the following two commands:

Command Description

Delete Removes the selected node (and its sub-nodes) from the DTM Browser.

Properties Opens the following dialog, which you can use to identify the name of the 
missing DTM:
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DTM Browser Menu Commands

Overview

The DTM Browser includes a pop-up, contextual (right-click) menu that displays 
commands for the currently selected DTM. The list of available commands consists 
of:

universal commands, as determined by the selected node level:
Host PC node (level 1)
communication module node (level 2)
remote device node (level 3)

device-specific commands, as determined by the device DTM

Host PC Node Commands

The Host PC node contextual menu includes the following commands:

Name Description

Add device1 Opens the Add dialog—containing a subset of the Hardware Catalog, 
allowing the selection of a communication module DTM.

Check devices1 Checks the current project for invalid DTMs or DTMs that are not 
installed in the PC. If the results of the check include invalid or not-
installed DTMs, they are displayed in the User errors tab in the 

information window and a red  is superimposed over their icons in 
the DTM Browser.

Expand all2 All DTMs in the project are displayed.

Collapse all2 Only the communication DTMs in the project are displayed.

1. This command also appears in the Unity Pro Edit menu.
2. This command also appears in the Unity Pro View menu.
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Communication Module and Remote Device Node Commands

The DTM Browser’s contextual menu has the following items:

Name Description

Open1 This opens the Device Editor for the selected communication 
module.
NOTE: Double-clicking the left mouse button on the DTM in the 
DTM Browser also opens this window.

Add 1 This opens the Add dialog, displaying a subset of the 
Hardware Catalog, allowing the selection of a DTM. 
NOTE: Unity Pro filters the content of the Add dialog, so that it 
displays only DTMs that are compatible with the selected DTM 
selected.

Delete1 If the selected DTM allows this function, this deletes the selected 
DTM and its sub-node DTMs from the DTM connectivity tree.
Deletion from the DTM connectivity tree does not affect the 
DTM’s link to the I/O Scanning table.

Field Bus Discovery This scans the connected physical devices to create the 
corresponding field bus topology. Refer to the topic Field Bus 
Discovery Service (see page 48).

Connect1 This connects the DTM (see page 46) to its physical device on 
the network. This connection does not depend on the PLC 
online/offline status of the Unity Pro project application.
NOTE: Connecting a Gateway- or Device-DTM implicitly 
connects its parent DTM.

Disconnect1 This disconnects the DTM (see page 46) from its physical 
device. This disconnection does not depend on the PLC 
online/offline status of the Unity Pro project application.
NOTE: Disconnecting a Gateway- or Device-DTM implicitly 
disconnects its parent DTM.

Load data from device1 This command is disabled.

Store data to device1 This command is disabled.

Device Menu This command opens a sub-menu that contains device-specific 
commands, as determined by the device vendor.
Refer to the section communication module commands, below, 
for details.

Properties1 Opens the Ethernet communication module Properties window.

1. This command also appears in the Unity Pro Edit menu.
2. This command also appears in the Unity Pro View menu.
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Communication Module Commands

When you select Device menu in the main contextual menu for the communication 
module, a sub-menu with the following commands is displayed:

Print device1 If this optional function is supported by a DTM, this function 
displays the device documentation—including configuration 
settings—in the PC’s default Internet browser, which can then be 
printed.
NOTE: Device information can be printed:

for only one device DTM at a time, when that DTM is not open 
for editing in the Device Editor 
only when the DTM is disconnected from the physical device

Zoom in2 This displays only the selected DTM node and its child DTMs.

Zoom out2 This returns to the full display of the DTM connectivity tree.

Expand all2 This displays all DTMs below the selected DTM.

Collapse all2 This displays only the selected DTM.

Name Description

1. This command also appears in the Unity Pro Edit menu.
2. This command also appears in the Unity Pro View menu.

Name Description

Configuration This opens the Device Editor for the selected communication module, 
when the module and its DTM are disconnected.

Diagnostic This opens the Diagnostic Window for the selected communication 
module, when the module and its DTM are connected.

Add EDS to library Opens the EDS File Wizard (see page 110), which you can use to add 
a device EDS file to the Unity Pro EDS device library. Unity Pro will 
display the contents of EDS files as DTMs for use in the DTM Browser 
and Device Editor.

Remove EDS from 
library

Opens the EDS Deletion from Device Library (see page 115) window, 
which you can use to delete an EDS file from the device library.

Online Action Opens the Online Action window (see page 253). Depending upon the 
protocol(s) a remote device supports, you can use the Online Action 
window to:

Ping (see page 258) a remote EtherNet/IP or Modbus TCP device
view and write to EtherNet/IP properties (see page 254) in a remote 
EtherNet/IP device
view and write to port configuration properties (see page 256) in a 
remote EtherNet/IP device

EtherNet/IP 
Explicit Message

Opens the EtherNet/IP Explicit Message (see page 286) window, 
which you can use to send explicit messages to EtherNet/IP remote 
devices.
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Connecting and Disconnecting a Device or Module DTM

A device or module DTM can be either connected to, or disconnected from the 
physical device or module.

NOTE: Be sure to distinguish between:

connecting and disconnecting a DTM and the associated physical device using 
commands in the DTM Browser, and
placing Unity Pro in online or offline operating mode using commands in the Unity 
Pro PLC menu

You can connect a DTM to, or disconnect a DTM from a device or module using the 
contextual pop-up menu in the DTM Browser. The DTM Browser indicates the 
relationship between the DTM and the remote module or device: a connected DTM 
is displayed in bold text; a disconnected DTM is displayed in normal text.

To connect a DTM to, or disconnect a DTM from its respective module or device, 
follow these steps:

Modbus TCP 
Explicit Message

Opens the Modbus TCP Explicit Message (see page 289) window, 
which you can use to send explicit messages to Modbus TCP remote 
devices.

Advanced Mode Displays or hides expert-level properties that help define Ethernet 
connections. See the topic Enabling Advanced Mode (see page 47) for 
instruction on how to use this feature.

Name Description

When a device and its DTM are... You can use the Ethernet configuration tool to...

Connected Monitor and diagnose the real-time operation of the 
device or module

Disconnected Configure a communication module or remote device 
by editing its properties

Step Action

1 In the DTM Browser select the DTM that you want to connect to, or disconnect 
from, the physical communication module or remote device.
NOTE: If the module or device name appears in: 

bold text, it is connected and only the Disconnect command is enabled
normal text, it is disconnected and only the Connect command is enabled

2 Click the right mouse button. A pop-up menu opens.

3 Select one of the following commands:
Connect 
Disconnect

NOTE: The Connect and Disconnect commands are also available in the Unity 
Pro Edit menu.
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Enabling Advanced Mode

Use the contextual menu in the DTM Browser to toggle Unity Pro in or out of 
Advanced Mode, thereby displaying or hiding expert-level properties that help 

define Ethernet connections. These properties are identified by the  icon, and 

should be configured only by persons with a solid understanding of communication 
protocols.

To toggle Advanced Mode on and off: 

Step Action

1 Close both the Diagnostic Window and all instances of the Device Editor before 
attempting to toggle Advanced Mode on or off.
NOTE: If the Device Editor or the Diagnostic Window is open, the 
Advanced Mode status—on or off—cannot be changed.

2 In the DTM Browser, click the right mouse button on the communication module. 
A pop-up menu opens.

3 To toggle ON advanced mode, select Device Menu → Advanced Mode.

4 To toggle OFF advanced mode, repeat steps 1 through 3, above. 
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Field Bus Discovery Service

Introduction

Use the field bus discovery service to detect, and add to your Unity Pro application, 
network devices that are situated on a local channel. The field bus discovery service 
is available only when the Ethernet communication module DTM is connected to its 
physical device.

Only the first level devices below the communication DTM are detected.

Performing Field Bus Discovery

The results of the scanning process is compared to the registered DTMs in the DTM 
catalog of the computer. If a match is found in the DTM catalog for a scanned device, 
the results are accompanied with a matching type that gives the accuracy of the 
match.

The three available matching types are:
Exact match:
All identification attributes are matching. The correct device type was found.
Generic match:
At least the Vendor and device Type ID attributes match. The support level of 
DTM is “Generic Support”.
Uncertain match: 
At least the Vendor and device Type ID attributes match. The support level of 
DTM is not “Generic Support”.

The following procedure explains how to use the field bus discovery service: 

Step Action

1 In the DTM Browser, select an appropriate DTM.

2 Right click, and in the pop-up menu and select Field bus discovery.
The Field bus discovery dialog opens:
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3 If necessary, select a channel and a protocol:
if the DTM has more than one channel
if the channel supports more than one protocol

4 Click on OK. The service starts to detect devices on the selected channel.
NOTE: The field bus discovery service limits its search to only the range of IP 
addresses that is pre-configured for the selected channel in the 
Channel Properties page (see page 59).

5 If at least one matched device has been found, the Field Bus Discovery dialog 
displays a list of Scanned Devices.

6 Use the controls of the Field Bus Discovery dialog to select the devices to add to 
your Unity Pro application.

7 After you have selected all the devices you want to add in the Field Bus Discovery 
dialog, click OK. 

8 If the field bus discovery process has found one or more devices with an IP address 
that is already in use in the project, you will be asked if you want to continue and 
replace the existing project deviice(s). Click Yes and proceed to step 9, below, or 
No to cancel automatic field bus discovery.

9 The device properties dialog (below) opens, displaying the default name for the first 
discovered device to be added: 

In the General page of the device properties dialog, type in the Alias name for the 
device to be added, then click OK. The dialog closes, then re-opens if there is 
another device to be added to the application.

10 Repeat step 9 for each additional discovered device. 

11 After all devices have been added to the application, you must configure each 
device for operation as part of the application. To do this:

disconnect the Ethernet communication module from its DTM. In the 
DTM Browser, select the Ethernet communication module, then select Edit → 
Disconnect.
configure the new device properties in the DTMs for both the Ethernet 
communication module, and the newly added remote device. 

Step Action
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Field Bus Discovery Dialog

If at least one matched device has been found, the Field Bus Discovery dialog box 
is displayed listing the scanned and matched devices. Select the matched devices 
to be created in the Unity Pro project (which then shows up in the Selected Devices 
list:

This dialog presents three lists:

This list... Displays...

Scanned Devices All the devices (matched and unmatched) found during the scan.

Matched Devices The matched DTMs found in the workstation DTM catalogue for the 
device that you selected in the Scanned Devices list.
Each time a scanned device is selected in the Scanned Devices list, 
the contents of the Matched Devices list is updated to display the 
matched device DTMs found for the selected scanned device.
The matching process can yield one or more matched devices for a 
given scanned device. In this case, only one DTM was discovered for 
the selected scanned device.

Selected Devices This list displays the device DTMs that have been selected in the 
Matched Devices list, which will be added to the Unity Pro project.
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The lists use the following colored icons:

This dialog has five buttons:

This color... Indicates...

Green The device has been selected

Yellow The device has been matched

Red The device has not been matched

Black Information about the address of the scanned device: 
In the Scanned Devices list, the device has an address identical to one 
of the DTMs in the Unity Pro project
In the Matched Devices list, the device will be assigned an address 
identical to one of the DTMs in the Unity Pro project

NOTE: An icon can consist of two colors. For example, a search can discover a device that:

has a matching DTM, and
has an IP address identical to a device already added to the Unity Pro application

In this case, the icon next to the discovered device would be:
half yellow and half black, before it is selected, and
half green and half black, after it is selected

Button Use this button to...

Add All Automatically add the best matched (according to the matching types listed 
above) device DTM for each found device in the Matched Devices list to the 
Selected Devices list.

Add One Add the matched device DTM selected in the Matched Devices list.

Remove Remove one or more devices from the Selected Devices list.

OK Insert the device DTMs in the Selected Devices list into the Unity Pro project.
If there are one or more devices in the Selected Devices list that have he 
same address in the Unity Pro project, a message box opens asking if you 
want to continue.
If you click OK, all devices in the Unity Pro project that have identical 
addresses as the selected devices are deleted and replaced by the DTMs 
selected in the Selected Devices list.

Cancel Cancel the field bus discovery scan and do nothing. All information in the three 
lists is discarded.
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Device Editor

Description

Use the Device Editor to view and configure Ethernet communication modules and 
remote devices. The collection of properties you can view or configure depends on:

the node type selected in the DTM Browser: 
communication module
remote device

whether Unity Pro is operating in Advanced Mode

Displaying Properties of the Ethernet Communication Module

After you open the BMX NOC 0401 Ethernet communication module in the 
DTM Browser, the left pane (1, below) of the Device Editor displays a tree control 
containing configurable property groups for the communication module. Click on a 
node in the tree control to display one or more pages of module properties for the 
selected group in the right pane (2, below).
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Property Types

The Device Editor displays an icon next to many device properties. The following 
three icons are displayed:

Displaying Property Definitions

Many property configuration pages provide an on-screen definition of the property 
you are editing. To display a property definition in the Description section of the 
page, select that property in the property list. The following screen displays a 
description of the Gateway IP Address property.

NOTE: The page displayed above can be accessed by opening an Ethernet 
communication module in the Device Editor, and then selecting 
Channel Properties → TCP/IP in the navigation tree.

This icon... Indicates the property is...

Read-only. The property value cannot be edited in this page.

Read-write. The property value can be edited in this page.

An expert-level communication protocol property that is displayed only when 
Advanced Mode is enabled. 
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Configuring Properties in the Device Editor

Configuring Properties

The Device Editor can be opened from the DTM Browser. 

To open the DTM Browser select Tools → DTM Browser in the Unity Pro main 
menu.

To use the Device Editor: 

Step Description

1 Confirm that the DTM you want to use is not connected to the actual communication 
module or device. If necessary, disconnect the DTM from the module or device 
(see page 46).

2 In the DTM Browser, select the Ethernet network node you want to configure, 
which can be either:

an Ethernet communication module, or
a remote device

3 With a node selected in the DTM Browser, do one of the following:
in the Unity Pro main menu, select Edit → Open, or
in the DTM Browser click the right mouse button and, in the pop-up menu 
(below), select Open:

The Device Editor displays configurable properties for the selected module or 
device.



Configuring

S1A34009 07/2011 55

4 Expand the navigation tree and select a node in the left window pane to display its 
properties in the right pane. The list of configurable properties varies, depending on 
the node type—communication module or remote device—selected in the 
DTM Browser.

5 While you edit a parameter, Unity Pro displays an icon—next to the field you are 
editing and in the navigation tree—indicating the parameter value is being edited. 
Unity Pro displays one of the following icons: 

This icon... Indicates the importance of the parameter being edited is...

High: editing this parameter may limit or deny access to the 
module or device.

Low: editing this parameter will not limit or deny access to the 
module or device.

6 After you finish editing a page, click:
Apply to save your edits and keep the page open, or
OK to save your edits and close the page

NOTE: Your edits will not take effect until they are successfully downloaded from 
your PC to the CPU, and from the CPU to the communication modules and network 
devices.

Step Description
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Uploading and Downloading DTM-Based Applications

Introduction

You can use Unity Pro to download an application file from your PC to the PLC, and 
to upload an application file from the PLC to your PC. 

To successfully complete an upload, the application file must include specific 
upload-related information as part of the application. 

Downloading DTM-Based Applications

Unity Pro applications that include DTM files require more memory than traditional 
Unity Pro applications. The following products employ DTMs for network 
configuration:

140 NOC 771 01 Ethernet Communication Module for Quantum
TSX ETC 101 Ethernet Communication Module for Premium
BMX NOC 0401 Ethernet Communication Module for M340

In some cases, the configurations created for these modules—and the data 
associated with them—will require more memory than is available in the CPU.

If the amount of memory required by an application exceeds the amount of memory 
that is available in the CPU, Unity Pro provides notice of this condition during the 
build process, before the application is downloaded to the PLC.

When this situation occurs, you must exclude the additional upload-related 
information from the application to complete the build and enable the application 
download. To do this, make the following configuration change in Unity Pro:

Step Action

1 In the main menu, select Tools → Project Settings... The Project Settings window 
opens.

2 In the left pane of the Project Settings window, select General → 
PLC embedded data.
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After the Upload information setting is disabled, you can build the application and 
download it to the PLC.

NOTE: An application in which the Upload information setting has been disabled 
cannot later be uploaded from the PLC to the PC.

Uploading DTM-Based Applications

DTM-based applications that were successfully downloaded to Unity Pro—with the 
project’s Upload information setting enabled—can later be uploaded from the PLC 
to the PC if the following pre-conditions exist:

DTM-based applications that were successfully downloaded to Unity Pro—with the 
project’s Upload information setting enabled—can later be uploaded from the PLC 
to the PC if the target PC has the following files installed on it:

 a version of Unity Pro that is equal to or higher than the version used to create 
the application
the master DTMs for the modules included in the configuration

NOTE: The Ethernet Configuration Tool installation CD contains the Master DTMs 
for all the Ethernet communication modules, referenced above.

the device DTMs for all DTM-based devices attached to the network (the DTMs 
must be of the same or higher revision as each device DTM used in the 
configuration)
the device EDS files for any EtherNet/IP device used in the configuration (the 
EDS files must be of the same or higher revision as each device EDS file used in 
the configuration)

After all the above components have been installed on the target PC, you can 
upload a DTM-based Unity Pro application from a PLC.

NOTE: All of the above DTM components must be installed on the target PC before 
attempting the upload.

3 In the right pane, de-select Upload information:

4 Click OK to save your changes and close the Project Settings window.

Step Action
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2.4 Channel Properties

Overview

This section describes how to configure channel properties for the Ethernet network.

What’s in this Section?

This section contains the following topics:

Topic Page

Channel Properties Page 59

Channel Properties - Switch Settings 61

Channel Properties - QoS Queue 63

Channel Properties - TCP/IP Page 66

Channel Properties - EtherNet/IP Page 71
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Channel Properties Page

Description

Use the Channel Properties page to:
select the IP address to use for:

connecting module or device DTMs to physical devices, and
sending explicit messages to Modbus TCP and EtherNet/IP devices

view your PC’s IP address settings

The Channel Properties page looks like this:

To display this page, select the Channel Properties node in the navigation tree 
located on the left side of the Device Editor.

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.
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Properties

This page presents the following properties:

Name Description

Source Address area:

Source IP Address: A list of IP addresses assigned to network interface cards installed 
on your PC.

Sub-Network Mask: The subnet mask associated with the selected Source IP Address.

EtherNet/IP Network Detection area:

Begin detection 
range address

The starting IP address of the address range for automatic field bus 
discovery of EtherNet/IP devices. 

End detection 
range address

The ending IP address of the address range for automatic field bus 
discovery of EtherNet/IP devices. 

Modbus TCP Network Detection area:

Begin detection 
range address

The starting IP address of the address range for automatic field bus 
discovery of Modbus TCP devices. 

End detection 
range address

The ending IP address of the address range for automatic field bus 
discovery of Modbus TCP devices. 
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Channel Properties - Switch Settings

Description

Use the Switch tab of the Switch page to:
enable or disable each of the four Ethernet ports on the BMX NOC 0401 
communication module
view and edit the Baud Rate for each port, which includes both the:

transmission speed, and
duplex mode

NOTE: The Ethernet communication module supports only the Ethernet II frame 
type.

The Switch page looks like this:

To display this page, select the Channel Properties → Switch node in the 
navigation tree located on the left side of the Device Editor, then click on the 
Switch tab.

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.
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Properties

This page presents the following properties:

Name Description

Port (read-only) The Ethernet port number: 1...4. 

Enabled The active status of the port:
Yes = enabled
No = disabled

Baud Rate The transmission speed and duplex mode for the network. Values 
include:

Auto 10/100 Mb (default)
100 Mb Half
100 Mb Full
10 Mb Half
10 Mb Full

NOTE: Schneider Electric recommends the default setting—Auto 
10/100 Mb. This setting causes the connected devices to perform 
auto-negotiation and thereby determine the fastest common 
transmission rate and duplex mode.
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Channel Properties - QoS Queue

Description

The BMX NOC 0401 Ethernet communication module can be configured to sort 
packets it receives by placing them into one of 4 separate queues—based upon their 
priority (very high, high, low, very low)—and handle each packet in the order of its 
priority.

The module also can be configured to add a differentiated service code point 
(DSCP) value to each packet it originates, indicating the relative priority of the 
packet.

The process of packet queuing and DSCP tagging together enable the module to 
perform Ethernet packet traffic management.

Use the QoS Queue tab of the Channel Properties → Switch page to assign 
differentiated service code point (DSCP) values and queueing priorities to Ethernet 
packets based on their message type.

NOTE: 

The settings input in this page are synchronized with the values input in the 
Services → QoS page (see page 87). Edits to a common property in either page 
will change that value in the other page.
The Explicit Message group settings are editable only when Unity Pro is 
operating in Advanced Mode. 
Be sure that all switches in your network adopt the same DSCP tagging scheme, 
thereby providing consistent packet traffic management throughout your network.
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The QoS Queue page, displaying the default settings, looks like this:

To display this page, select the Channel Properties → Switch node in the 
navigation tree located on the left side of the Device Editor, then click on the QoS 
Queue tab.

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.
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QoS Queue Mapping Settings

All DSCP settings have a range of 0...63. The range of Queue Mapping settings are 
set forth below:

Group Traffic Type Available Group Queue Settings

Precision Time Control Point-to-point event Very High, or
HighPoint-to-point general

I/O Data Exchange1 Urgent High, or
Low, or
Very Low

Scheduled

High

Low

Explicit Message1,2 Modbus TCP Low

EtherNet/IP

1. Edits to these properties are synchronized with the Services → QoS page (see page 87). 
2. Editable only in Advanced Mode.
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Channel Properties - TCP/IP Page

Description

Use the TCP/IP page to:
select a Configuration mode, which specifies how the communication module 
obtains its IP addressing settings, and
edit the IP addressing settings that will be used if the Configuration mode is set 
to Static

NOTE: The settings made in this page can either match or conflict with the manual 
settings made using the two rotary switches on the back of the module 
(see page 15). See the topic Resolving Conflicting Hardware and Software IP 
Address Settings (see page 69) for an explanation of when IP addressing conflicts 
exist and how the module resolves them.

The TCP/IP page looks like this:

To display this page, select the Channel Properties → TCP/IP node in the 
navigation tree located on the left side of the Device Editor.

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.
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Properties

The IP addressing properties you can configure in this page depends upon the 
selected configuration mode:

Selecting a Configuration Mode

Use the Configuration list to specify a configuration mode. The configuration mode 
setting determines how the communication module obtains its IP address at startup. 
Choices are:

Property Description Configuration 
Mode Options

Scanner IP Address The 32-bit identifier—consisting of both a network 
address and a host address—assigned to a device 
connected to a TCP/IP Internet network using the 
Internet Protocol (IP).

Static
Flash memory
BOOTP
DHCP

Sub-Network Mask The 32-bit value used to hide (or mask) the 
network portion of the IP address and thereby 
reveal the host address of a device on a network 
using the IP protocol.

Static

Gateway Address The address of a device, if any, that serves as a 
gateway to the communication module.

Static

Name The device name. 
NOTE: The default device name, based on the 
rotary switch settings is BMX_0401_xxy. where:

xx is the value of the upper switch setting (tens)
y is the value of the lower switch setting (ones)

DHCP

Configuration Mode Description

Static The module uses the scanner IP address, gateway IP address, 
and sub-network mask configured in this page.

Flash Memory The module uses the IP address configured via the TCP/IP object 
and stored flash memory. An IP address configured by this 
process survives both a warm and a cold re-start.

BOOTP The module uses an IP address assigned by a BOOTP server.

DHCP1 The module uses an IP address assigned by a DHCP server.
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Default Address Configurations

The communication module uses a default address configuration when it is not 
configured or when a duplicate IP address is detected. The default address is based 
on the MAC address of the module and makes it possible for several Schneider 
Electric devices to use their default network configuration on the same network. 

The module uses the following default address configurations:
Default IP Address
This default address starts with 10.10 and uses the last two bytes of the MAC 
address. As an example, a device with the MAC address of 00:00:54:10:8A:05 
has a default IP address of 10.10.138.5 (0x8A=138, 0x05=5).
Default Sub-Network Mask
The default address is 255.0.0.0 (a class A mask).
Default Gateway Address
The default gateway address is identical to the default IP address.

Duplicate Address Checking

Before going online, the module sends out at least four ARP (Address Resolution 
Protocol) messages with a proposed IP address:

if an answer is returned:
another network device is already using the proposed IP address
the module will not use the proposed IP address, but will instead use the 
default IP address

if an answer is not returned:
the module is assigned the proposed IP address (along with the associated 
network parameters.)

NOTE: When powering up an entire network, some switches may be slow to 
complete the power up process. This can cause some ARP messages to be 
dropped. To help avoid this situation, Schneider Electric recommends that, when 
powering up an entire network, be sure that all network switches complete their 
power up cycle before powering up the PLCs.
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Resolving Conflicting Hardware and Software IP Address Settings

The following table summarizes the status of the Ethernet channel depending on the 
Configuration Mode set in the application, and the positions of the two rotary 
switches on the back of the module:

Application:
Configuration 
Mode

Rotary Switch Position

DHCP1 BOOTP STORED CLEAR IP

<no configuration> No Conflict: Get IP address 
from DHCP server using 
device name from rotary 
switches.
Start basic services only.

No Conflict: Get 
IP address from 
BOOTP server.
Start basic services 
only.

No Conflict: Get 
IP address from:

flash memory, or
BOOTP server, or
use default 
IP address

Start basic services 
only.

No Conflict: 
Use default 
IP address.
Start basic 
services only.

Static or 
Flash memory

Conflict: Get IP address from 
DHCP server using device 
name from rotary switches.
Start basic services only.

Conflict: Get 
IP address from 
BOOTP server.
Start basic services 
only.

No Conflict: Get 
IP address from the 
application.
Start all services 
configured in the 
application.

DHCP or BOOTP 
with no configured 
device name

No Conflict: Get IP address 
from DHCP server using 
device name from rotary 
switches.
Start all services configured in 
the application.

No Conflict: Get 
IP address from 
BOOTP server.
Start all services 
configured in the 
application.

No Conflict: Get 
IP address from 
BOOTP server.
Start all services 
configured in the 
application.

DHCP with a 
configured 
device name

Conflict (if device name on 
switches differs from name in 
application) or No Conflict: if 
names are equal. 
Get IP address from DHCP 
server using device name from 
rotary switches.
If conflict, start basic services 
only; If no conflict, start all 
services configured in the 
application.

Conflict: Get 
IP address from 
BOOTP server.
Start basic services 
only.

No Conflict: Get 
IP address from 
DHCP server using 
device name from 
application.
Start all services 
configured in the 
application.

1. Based on device name BMX_0401_xxy, where x = the top rotary switch, and y represents the bottom rotary switch.
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Basic Services

The following services are provided by the module when it is using its default IP 
address:

FTP server (used for firmware download)
HTTP/Web server
Modbus/TCP server
EtherNet/IP explicit message server
SNMP agent

NOTE: Using the module as a messaging server, when the module is using its 
default IP address, is not recommended. The module will replace the default IP 
address with a served or user-configured IP address as soon as one is received.
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Channel Properties - EtherNet/IP Page

Description

The EtherNet/IP page is displayed only when Unity Pro is operating in Advanced 

Mode (see page 47). Advanced mode properties are identified by the  icon. 

Use the EtherNet/IP page to configure the following communication module 
properties:

properties that determine how the communication module, as a scanner, opens 
connections for both implicit and explicit messages
the frequency for transmitting produced data over implicit messaging connections
the timeout period for explicit messaging connections
the behavior of the communication module—as a scanner—when:

the application is stopped, or
the communication module receives a reset service request

The EtherNet/IP page looks like this:

To display this page, select the Channel Properties → EtherNet/IP node in the 
navigation tree located on the left side of the Device Editor.

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.
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Properties

Note: Only users experienced in the configuration of EtherNet/IP networks should 
edit any of the following read-write properties.

Name Description

Timeout

FW_Open IO Connection Timing The amount of time the communication module waits 
for the Forward_Open IO messaging transaction to 
open an implicit messaging connection. 
Default = 5000 ms

FW_Open EM Connection Timing The amount of time the communication module waits 
for the Forward_Open IO messaging transaction to 
open an explicit messaging connection. 
Default = 3000 ms

EM Connected RPI The value used to set the T->O (target to originator) 
and O->T (originator to target) requested packet 
interval (RPI) for all explicit message connections. 
This value is used to calculate the lifetime of a 
connection. Default = 10000 ms.

EM Request Timeout The amount of time the communication module waits 
between a request and reply of an explicit message. 
Default =10 s.

Output

Allow reset explicit message The behavior of the communication module—as 
scanner—when it receives a reset service request:

TRUE indicates the module will accept the request 
and reset itself. 
FALSE indicates the module ignores the reset 
service request and continues uninterrupted 
operations.
Default = FALSE

Behavior when CPU state is STOP The state of the communication module when the CPU 
application goes into a STOP state:

TRUE indicates that the module enters STOP state 
(implicit connections are closed). 
FALSE indicates that the module enters IDLE state 
(implicit connections are not closed).
Default = FALSE
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2.5 Ethernet Services

Overview

This section describes how to enable and configure Ethernet services provided by 
the BMX NOC 0401 communication module.

What’s in this Section?

This section contains the following topics:

Topic Page

Enabling Ethernet Services 74

Configuring the DHCP and FDR Servers 76

Configuring the SNMP Agent 82

Configuring Access Control 85

Configuring QoS Ethernet Packet Tagging 87

Configuring the Rapid Spanning Tee Protocol 89
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Enabling Ethernet Services

Service List

Use the Services page to enable and disable Ethernet services provided by the 
communications module.

NOTE: After you enable a service, you can configure its settings. If you do not 
configure a service, Unity Pro applies its default settings.

The Services page looks like this:

To display this page, select the Services node in the navigation tree located on the 
left side of the Device Editor.

After you Enable a service in this page, the next step is to configure that service. 
Depending upon the specific service, it can be configured in either the Unity Pro 
Device Editor (by selecting a node beneath the Services parent node) or in the 
module’s web pages. 

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties in Unity Pro.
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Service Descriptions

The Ethernet communication module can be configured to provide the following 
services:

This service... Enables the module to... Configurable in...

SNMP serve as an SNMP v1 agent
provide trap information to up to two devices configured as SNMP 
managers.

NOTE: The SNMP service is always enabled.

Device Editor

Access Control deny access to the Ethernet communication module from unauthorized 
devices.

Device Editor

Address Server provide both IP addressing parameters and operating parameters to 
other Ethernet devices.

Device Editor

QoS Tagging add Differentiated Services Code Point (DSCP) tags to Ethernet 
packets so that network switches can prioritize the transmission and 
forwarding of Ethernet packets.

Device Editor

I/O Communication 
Control

allow the Unity Pro application to control the enabling and disabling of 
individual connections between the communication module and remote 
I/O devices. 
NOTE: 

The application can open and close individual connections using the 
control bits located at the beginning of the output area. 
If this service is disabled the user—via the application program—
cannot toggle on and off connection control bits 

Device Editor

RSTP employ the rapid spanning tree protocol (RSTP)—in combination with 
other similarly-configured network devices—to manage redundant 
physical connections and create a loop-free logical path connecting all 
network devices. 

Device Editor

Port Mirroring duplicate the traffic entering and exiting any one of the four Ethernet 
ports onto another one of the ports, for the purpose of diagnosing the 
original port.

Web pages

IGMP Snooping restrict outbound multicast transmissions to only those ports with 
downstream consumers. 

<no configuration 
required>
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Configuring the DHCP and FDR Servers

Description

The Ethernet communication module includes both a DHCP and a Faulty Device 
Replacement (FDR) server. The DHCP server provides IP address settings to 
networked Ethernet devices. The FDR server provides operating parameter settings 
to replacement Ethernet devices that are equipped with FDR client functionality.

Use the Address Server page to:
enable and disable the communication module’s FDR service
view an automatically generated list of all devices included in the communication 
module’s Ethernet configuration, displaying for each device:

IP addressing parameters, and
whether the device’s IP addressing parameters are provided by the 
communication module’s embedded DHCP server

manually add remote devices—that are not part of the communication module’s 
Ethernet configuration—to the communication module’s DHCP client list

NOTE: Remote devices added in this way must come equipped with DHCP client 
software, and be configured to subscribe to the communication module’s IP 
addressing service. 

The Address Server page looks like this:



Configuring

S1A34009 07/2011 77

To display this page:

Enabling the FDR Service

To enable the communication module’s FDR service, set the FDR Server field to 
Enabled. To disable the service, toggle the same field to Disabled. 

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to apply edited properties to networked devices.

Any networked Ethernet device equipped with FDR client functionality can subscribe 
to the communication module’s FDR service. The communication module can store 
up to 1 MB of FDR client operating parameter files. When this file storage capacity 
is reached, the module can not store any additional client FDR files. 

The communication module can store FDR client files for up to 128 devices, 
depending on the size of each stored file. For example, if the size of each FDR client 
file is small—not more than 8 Kb—the module could store up to the maximum of 128 
parameter files.

Manually Adding Remote Devices to the DHCP Service

Remote devices that are part of the communication module’s Ethernet 
configuration—and which have subscribed to the communication module’s IP 
addressing service—automatically appear in the Automatically Added Devices 
list.

Other remote devices—that are not part of the communication module’s 
configuration—can be manually added to the communication module’s DHCP IP 
addressing service.

Step Description

1 Select the Services node in the navigation tree located on the left side of the 
Device Editor. The Services page opens. 

2 In the Services page, set the Address Server field to Enabled. The Address 
Server node appears in the navigation tree. 

3 Select the Address Server node in the navigation tree. 
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To manually add networked Ethernet devices, which are not part of the 
communication module’s Ethernet configuration, to the communication module’s IP 
addressing service:

Viewing the Auto-Generated DHCP Client List

The list of Automatically Added Devices includes a row for each remote device 
that is:

part of the communication module’s Ethernet configuration, and
configured to subscribe to the communication module’s DHCP addressing 
service

NOTE: You cannot add devices to this list in this page. Instead, use the 
configuration pages for the remote device to subscribe to this service.

The list of Automatically Added Devices contains the following information for 
each networked device:

Step Description

1 In the Address Server page, click the Add Device Manually button. Unity Pro adds an empty row to the list 
of Manually Added Devices.

2 In the new row, configure the following parameters for the client device:

IP Address Type in the IP address of the client device.

Identifier Type Select the type of value the client device will use to identify itself to the FDR server:
MAC address 
Device Name

Identifier Depending upon the identifier type, type in the client device setting for the MAC address 
or Name.

Mask Type in the client device subnet mask.

Gateway Type in the gateway address that remote devices can use to communicate with devices 
located on other networks. Use 0.0.0.0 if remote devices will not communicate with 
devices located on other networks.

3 Refer to the topic Configuring Properties in the Device Editor (see page 54) for instructions on how to apply 
edited properties to networked devices. 

Property Description

Device Number The number assigned to the device in the Unity Pro configuration.

IP Address The client device IP address.

Enable DHCP TRUE indicates that the device subscribes to the DHCP service.

Identifier Type Indicates the mechanism used by the server to recognize the client (MAC address or DHCP device 
name).

Identifier The actual MAC address or DHCP device name.

Mask The client device subnet mask.

Gateway The IP address a DHCP client device will use to access other devices that are not located on the 
local subnet. A value of 0.0.0.0 constrains the DHCP client device by allowing it to communicate 
only with devices on the local subnet.
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Subscribing to the DHCP Service for a Device that is Part of the Configuration

An Ethernet device—that is part of the communication module Ethernet 
configuration—can subscribe to the communication module’s IP addressing service. 
To subscribe to this service, follow these steps:

Step Action

1 In the DTM Browser, select the Ethernet communication module that is connected 
to the remote device that you want to add to the DHCP service. In the following 
example, the communication module with the alias name of NOC01 is selected:

NOTE: The selected module is connected to the STB NIC 2212 network interface 
device bearing the alias name NIC2212_01, which is the module you want to add to 
the DHCP service.

2 With NOC01 selected in the DTM Browser, click the right mouse button, and select 
Open in the pop-up menu.:

The Device Editor opens.
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3 In the navigation tree on the left side of the Device Editor, expand the Device List 
node and select the device for which you want to enable the DHCP service. In this 
example, select NIC2212_01:

Unity Pro displays the properties for the selected remote device in the right pane of 
the window.

4 In the right pane of the window, select the Address Setting tab to display the 
following page:

Step Action
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5 In the Address Server area of this page, configure the following properties:

DHCP for this device Select Enabled

Identified by The choices are:
MAC Address, or
Device Name

Select Device Name.

Identifier Unity Pro has automatically added the device name 
NIC2212_01. For the purpose of this example, accept 
this default value.

Subnet Mask Unity Pro has automatically applied the same subnet 
mask used for the Ethernet communication module. 
For the purpose of this example, accept the default 
value of 255.255.255.0.

Gateway For the purpose of this example, accept the default 
value of 0.0.0.0.

6 Click OK to save your edits.
NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for more information on editing and saving property settings in this window.

Step Action
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Configuring the SNMP Agent

Description

The Ethernet communication module includes an SNMP v1 agent. An SNMP agent 
is a software component running on the communication module that allows access 
to the module’s diagnostic and management information via the SNMP service. 

SNMP browsers, network management software, and other tools typically use 
SNMP to access this data. In addition, the SNMP agent can be configured with the 
IP address of up to two devices—typically PC’s running network management 
software—to be the target of event driven trap messages. These trap messages 
inform the management device of events such as cold start, and authentication 
failures.

Use the SNMP page to configure the SNMP agent in the communication module. 
The SNMP agent can connect to and communicate with up to 2 SNMP managers as 
part of an SNMP service. The SNMP service includes:

authentication checking, by the Ethernet communication module, of any SNMP 
manager that sends SNMP requests
management of event, or trap, reporting by the module

The SNMP page looks like this:
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To display this page:

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.

Viewing and Configuring SNMP Properties

NOTE: The sysName SNMP parameter is neither editable nor visible in the Unity 
Pro Ethernet Configuration Tool software. By default, the sysName is set to the 
Ethernet communication module part number.

When DHCP is enabled and Device Name is selected as the DHCP identifier for the 
module, the SNMP sysName parameter is not set to the module part number, but is 
instead the device name.

The following properties can be viewed and edited in the SNMP page:

Step Description

1 Select the Services node in the navigation tree located on the left side of the 
Device Editor. The Services page opens. 

2 In the Services page, set the SNMP field to Enabled, then click OK or Apply. 
The SNMP node appears in the navigation tree. 

3 Select the SNMP node in the navigation tree. 

Property Description

IP Address Managers:

IP Address Manager 1 The IP address of the first SNMP manager to which the 
SNMP agent sends notices of traps.

IP Address Manager 2 The IP address of the second SNMP manager to which 
the SNMP agent sends notices of traps.

Agent:

Location The device location (32 characters maximum)

Contact Information describing the person to contact for device 
maintenance (32 characters maximum)

SNMP Manager Select either:
TRUE: the Location and Contact information are 
editable in this page
FALSE: Location and Contact settings are not editable 
in this page 

Community Names:

Get Password required by the SNMP agent before executing 
read commands from an SNMP manager. 
Default = Public.
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Set Password required by the SNMP agent before executing 
write commands from an SNMP manager. 
Default = Public

Trap Password an SNMP manager requires from the SNMP 
agent before the manager will accept trap notices from the 
agent. Default = Public

Security:

Enable Authentication Failure 
Trap

TRUE causes the SNMP agent to send a trap notice to the 
SNMP manager if an unauthorized manager sends a Get 
or Set command to the agent. Default = FALSE.

Property Description
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Configuring Access Control

Description

Use the Access Control page to restrict access to the Ethernet communication 
module in its role as either a Modbus TCP or EtherNet/IP server. When access 
control is enabled in the Services page, you must add the IP addresses of the 
following devices to the list of Authorized Addresses to permit the intended 
communication with that device:

the Ethernet communication module itself, so that the module can use 
EtherNet/IP explicit messaging for any of the following purposes:

obtaining diagnostic data
resetting the module
changing the IP address

any client device that may send a request to the Ethernet communication module, 
in its role as either Modbus TCP or EtherNet/IP server
your own maintenance PC, so that you can communicate with the PLC via Unity 
Pro to configure and diagnose your application, and to view the module’s web 
pages
any target device to which the Ethernet communication module may send a 
Modbus TCP explicit message

NOTE: You do not need to list the IP address of a target device to which the 
communication module may send an EtherNet/IP explicit message. 

When access control is disabled in the Services page, the Ethernet communication 
module will accept Modbus TCP and EtherNet/IP requests from any device.

The following graphic depicts the Access Control page immediately after a new row 
has been added to the list of Authorized Addresses, but before the new item has 
been configured:
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To display this page:

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.

Adding and Removing Devices in the Authorized Address List

To add a device to the Authorized Addresses list:

To remove a device from the Authorized Addresses list, select its IP address in the 
list, then click Remove. The selected IP address is removed.

Step Description

1 Select the Services node in the navigation tree located on the left side of the 
Device Editor. The Services page opens. 

2 In the Services page, set the Access Control field to Enabled and click either 
OK or Apply. The Access Control node appears in the navigation tree. 

3 Select the Access Control node in the navigation tree. 

Step Description

1 In the Access Control page, click Add. 
A new row appears in the Authorized Addresses list, displaying:

a red exclamation point, indicating editing has begun, and
a placeholder IP address of 0.0.0.0

2 Double-click the left mouse button on the placeholder IP address.
The IP address field expands and becomes editable.

3 In the new IP address field, type in the IP address of the device which will be able 
to access the communication module, then press Enter.

4 Repeat steps 1 through 3, above, for each additional device to which you want 
to grant access to the communication module.

5 Refer to the topic Configuring Properties in the Device Editor (see page 54) for 
instructions on how to save your configuration edits. 
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Configuring QoS Ethernet Packet Tagging

Description

The Ethernet communication module can be configured to perform Ethernet packet 
tagging. The module supports the OSI layer 3 Quality of Service (QoS) standard 
defined in RFC-2475. When you enable QoS, the module adds a differentiated 
services code point (DSCP) tag to each Ethernet packet it transmits, thereby 
indicating the priority of that packet.

Use the QoS page to:
specify the source of QoS packet priority settings, and 
view or edit the five QoS DSCP prioritization values

The QoS page looks like this:

NOTE: The DSCP Value settings input in this page are synchronized with the same 
settings in the QoS Queue tab of the Channel Properties → Switch page. Edits to 
a common property in either page will change that value in the other page.

To display this page:

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.

Step Description

1 Select the Services node in the navigation tree located on the left side of the 
Device Editor. The Services page opens. 

2 In the Services page, set the QoS Tagging field to Enabled, then click OK or 
Apply. The QoS node appears in the navigation tree. 

3 Select the QoS node in the navigation tree. 
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Specifying the Source of QoS Settings

The five QoS prioritization values can be set either from the communication 
module’s flash memory, or in this page. To specify the QoS configuration source, set 
the Use value from field to either:

NOTE: You can also edit QoS configuration settings by using explicit messages to 
set the attributes of the QoS CIP object (see page 230).

Type of Traffic Settings

QoS tagging lets you prioritize Ethernet packet streams based on the type of traffic 
in that stream. The communication module recognizes the traffic types described 
below. When the Use value from field is set to Configuration, you can edit the 
prioritization values in this page. Each traffic type can have a prioritization value from 
0... 63.

To effectively implement QoS settings in your Ethernet network:
all network switches must support QoS
DSCP values must be consistently applied by all network devices and switches
all switches must apply a consistent set of rules for sorting DSCP tags, when 
transmitting and receiving Ethernet packets

NOTE: The QoS settings for Scheduled, High, and Low priority messages also apply 
to input and output priority messages for a remote device. You can configure these 
settings for a remote device (see page 129) in the Device Editor by selecting a 
device connection node, then opening the connection’s General page.

Setting Description

Configuration1 The communication module uses the settings input in the Type of Traffic 
section of this page. 

Flash1 The communication module uses the settings saved in the module’s flash 
memory. The fields in the Type of Traffic section are read-only.

1. Schneider Electric recommends that QoS values be set in the configuration, and not by 
saving settings to flash memory. Settings saved to flash memory will be lost if the module is 
replaced. 

Traffic Type Default 

DSCP Value for IO Data Urgent Priority Messages (EtherNet/IP) 55

DSCP Value for IO Data Scheduled Priority Messages (EtherNet/IP) 47

DSCP Value for IO Data High Priority Messages (Modbus TCP & EtherNet/IP) 43

DSCP Value for IO Data Low Priority Messages (EtherNet/IP) 31

DSCP Value for Explicit Message (Modbus TCP & EtherNet/IP) 27
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Configuring the Rapid Spanning Tee Protocol

Description

Ethernet ports 3 and 4, located on the front of the BMX NOC 0401 communication 
module, support the Rapid Spanning Tree Protocol (RSTP). RSTP is an OSI layer 
2 protocol defined by IEEE 802.1D 2004. RSTP performs two important services:

it creates a loop-free logical network path for Ethernet devices that are part of a 
topology that includes redundant physical paths
it automatically restores network communication—by activating redundant 
links—in the event the network experiences a loss of service

RSTP software, operating simultaneously in all network switches, obtains 
information from each switch which enables the software to create a hierarchical 
logical network topology. RSTP is a flexible protocol that can be implemented on 
many physical topologies, including ring, mesh, or a combination of ring and mesh.

Use the RSTP → General and the RSTP → Advanced pages to configure RSTP for 
the embedded Ethernet switch in the communication module.

NOTE: RSTP can be implemented only when all network switches are configured to 
support RSTP.

The RSTP → General page looks like this:
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The RSTP → Advanced page looks like this:

To display these pages:

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.

Step Description

1 Select the Services node in the navigation tree located on the left side of the 
Device Editor. The Services page opens. 

2 In the Services page, set the RSTP field to Enabled, then click OK or Apply. 
The RSTP node appears in the navigation tree. 

3 Select the RSTP node in the navigation tree, then click on either the General or 
Advanced tab to display that page. 
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Configuring RSTP Properties

The following properties can be viewed and edited in the RSTP → General page:

The following properties can be viewed and edited in the RSTP → Advanced page:

Property Description

RSTP Operation State: 
Bridge Priority

A 2-byte value for the switch, from 0 to 65535, with a default of 
32768 (the midpoint).
NOTE: Network switches running RSTP software periodically 
exchange information about themselves using special packets 
called Bridge Protocol Data Units (BPDUs), which act as a 
heartbeat. The Bridge Priority value is contained in the BPDU and 
establishes the relative position of the switch in the RSTP 
hierarchy.

Property Description

Bridge Parameters:

Maximum Age Time This value is set to The length of time, from 6 to 40 seconds, that the 
switch waits for receipt of the next hello message, before initiating a 
change to the RSTP topology. Default = 40 s.

Transmit Hold Count The maximum number of BPDUs, from 1 to 40, that the switch can 
transmit per second. Default = 40.

Hello Time (read-only) The frequency—set at 2 seconds—that the embedded 
switch sends heartbeat BPDUs.

Port Parameters (These properties can be separately configured for ports 3 and 4):

RSTP (read-only) This property is set to Enabled in the Services page.

Priority The priority assigned to the switch port, an integer from 0 to 240 in 
increments of 16. Default = 0. This value is used by the RSTP 
process if it needs to break a tie between two ports on the same 
switch when identifying a:

root port: the port on a non-root switch that is closest to the root 
bridge in terms of path cost, or
designated port: the port at one end of a network segment 
through which traffic must pass on its way to the root bridge

RSTP Cost The method used to determine the RSTP cost of the path through 
the embedded switch. Values include:

Auto—the RSTP protocol will automatically assign a value to the 
switch by operation of the RSTP algorithm
Manual—you must input the RSTP cost—an integer from 1 to 
200000000—in the Value field.

Edge Port (read-only) Set to a fixed value of Auto. The RSTP process 
automatically determines if the port is an RSTP edge port.

Point to Point (read-only) Set to a fixed value of Auto. The RSTP process 
automatically determines if the port is an RSTP point-to-point port.
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2.6 Configuring the Ethernet Communication Module 
as an EtherNet/IP Adapter

Overview

This section describes how to configure the Ethernet communication module to act 
as an EtherNet/IP adapter, using a functionality called Local Slave. The 
communication module supports up to three instances of local slaves. 

In its role as a EtherNet/IP adapter, the module initiates no messages. Instead, it 
responds to:

implicit messaging requests from a scanner device in the network, and
explicit messaging requests—directed to the communication module’s assembly 
object (see page 223)—from other devices on the network

NOTE: If no local slave instance is enabled, the communication module can respond 
to explicit messaging requests directed at its CIP objects (see page 219) other than 
the assembly object.

What’s in this Section?

This section contains the following topics:

Topic Page

Introducing the Local Slave 93

Configuring a Local Slave 95

Local Slave Inputs and Outputs 100
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Introducing the Local Slave

Local Slave Networking Example

The Ethernet communication module supports up to three instances of the local 
slave functionality. The local slave functionality allows other scanners on the 
network to read from, and write to, the Ethernet communication module using 
implicit messaging. Each local slave instance can accept one exclusive owner 
connection and one listen only connection. Through a local slave, a remote scanner 
can access the communication module’s CIP Assembly object (see page 223). The 
local slave function is especially beneficial for peer to peer data exchanges at a 
repetitive rate.

NOTE: 

The Ethernet communication module can provide three local slave adapter 
instances, while simultaneously performing as a scanner. These roles are not 
mutually exclusive.
The local slave is exclusively an EtherNet/IP functionality

In this example, the local slave instance is part of the following topology:
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The sample configuration, above, includes the following devices:
A primary PLC (1) incorporating the BMX NOC 0401 Ethernet communication 
module with one local slave instance enabled. The PLC scans I/O data from 
remote devices (4 and 5)
A secondary PLC (2) that “listens” to the scan of the primary PLC’s local slave by 
the third-party PLC (6)
A managed Ethernet switch (3)
An Advantys STB island (4), with an STB NIC 2212 EtherNet/IP network interface 
module plus 8 I/O modules
An Advantys STB island (5), with an STB NIP 2212 Modbus TCP network 
interface module plus 8 I/O modules
A third party scanner (6)—which lacks adapter capability, and therefore cannot 
itself be scanned by the primary PLC (1)—that:

collects data from other sources (not part of this network)
writes data to inputs of the primary PLC’s local slave
scans the primary PLC’s local slave’s output data via an exclusive owner 
connection 

A PC running the following software:
Unity Pro
the Unity Pro Configuration Tool
Advantys Configuration Software

NOTE: 

Because the third party scanner (6) and the secondary scanner (2) are both 
receiving the same data produced by the local slave, the requested packet 
interval (RPI) settings of the third party scanner’s exclusive owner connection and 
the secondary scanner’s listen only connection must be the same.
By enabling a local slave on the primary PLC (1): 

PLC (1) allows the third party PLC (6) to write to it at a repetitive rate, even if 
PLC (6) is not capable of acting as an adapter.
the secondary PLC (2) is able to scan the primary PLC (1) at a repetitive rate, 
rather than through application intensive explicit messaging.

The topics in this section show you how to use Unity Pro software installed in the PC 
(7, above) to configure a local slave, and to create input and output items in support 
of the peer-to-peer data transfers between and among scanners.
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Configuring a Local Slave

Description

The Ethernet communication module presents three identical Local Slave 
configuration pages. Use each page to configure a separate local slave instance. 
Create a local slave instance by:

enabling and naming the local slave
specifying the size of local slave input and output assemblies
configuring local slave variable names

To display this page, select one of the three Local Slave nodes in the navigation 
tree located on the left side of the Device Editor.

NOTE: Refer to the topic Configuring Properties in the Device Editor (see page 54) 
for instructions on how to edit properties.

The following steps describe a sample configuration for Local Slave 1. Your 
configuration may be different.

Configuration Example: Local Slave 1

In the sample network configuration, the application in the third-party PLC produces 
data, which is available in the PLC’s Ethernet communication module as inputs. In 
this example, the third-party device produces the following information:

production totals for manufacturing line A
production totals for manufacturing line B
the number of production interruption events for line A
the number of production interruption events for line B

Any information that needs to be passed to the third-party device—for example, 
confirmation that data from the third-party device has been received by the PLC—is 
accessible in the third-party device as input data. In this example, the third-party 
device is programmed to scan Local Slave 1 for this confirmation. 

When configuring inputs and outputs in both the local slave and the third-party PLC, 
be sure to associate inputs and outputs as follows: 

Associate these local slave items: With these third-party PLC items:

Outputs (T to O)—assembly instance 101 Inputs—assembly instance 101

Inputs (O to T)—assembly instance 102 Outputs—assembly instance 102
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The configured Local Slave page looks like this:
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Enabling and Naming the Local Slave

Use the Properties section of the Local Slave page to enable (or disable) and 
identify the local slave.

Configuring the Size of Local Slave Input and Output Assemblies

Use the Assemblies section of the Local Slave page to configure the size of the 
local slave inputs and outputs. The assembly numbers are non-editable, and are 
assigned by Unity Pro as follows:

Setting Description

Number The unique number—or identifier—assigned to the device. By 
default, Unity Pro assigns:

000 = local slave 1
001 = local slave 2
002 = local slave 3

In this example, accept the default 000.

Active Configuration Enabled activates the local slave.
Disabled de-activates the local slave, but saves the current local 
slave settings.

In this example, select Enabled.

Comment An optional free text comment field up to 80 characters maximum. 
In this example, leave blank.

Connection bit Auto-generated integer (0...127) indicating the offset of the 
connection’s:

health bit, located in the module’s input area
control bit, located in the module’s output area

Note: This setting is auto-generated after the local slave settings are 
input and the network configuration is saved.

Assembly number Local slave number Used for connection

101 1 T->O 1

102 1 O->T Exclusive Owner

103 1 Configuration

199 1 O->T Listen Only

111 2 T->O

112 2 O->T Exclusive Owner

113 2 Configuration

200 2 O->T Listen Only

1. In this table:
O indicates the originator—or scanner—device
T indicates the target—or adapter—device
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The Local Slave assembly settings include:.

NOTE: When using explicit messaging to read the Ethernet communication 
module’s assembly object, be sure to allocate sufficient room for the response, 
because the size of the response will equal the sum of:

the assembly size + Reply service (1 byte) + General Status (1 byte)

Configuring Local Slave I/O Variable Names

Each input and output that Unity Pro creates for your application has both a non-
editable structure name (used by Unity Pro to internally identify input and output 
items) and an editable variable name.

Use the I/O Structure Name section of the Local Slave page to:
view and edit local slave input and output variable names
view non-editable local slave structure names

121 3 T->O

122 3 O->T Exclusive Owner

123 3 Configuration

201 3 O->T Listen Only

Setting Description

Outputs (T->O) A read-only value (see table, above).
In this example, 101.

Outputs (T->O) Size The maximum size—in bytes—reserved for local slave outputs. An 
integer from 1 to 509. 
In this example, only two output bytes are used: type in 2. 

Inputs (O->T) A read-only value (see table, above).
In this example, 102.

Inputs (O->T) Size The maximum size—in bytes—reserved for local slave inputs. An 
integer from 0 to 505. 
In this example, only eight input bytes are used: type in 8. 

Configuration A read-only value (see table, above).
In this example, 103.

Configuration Size A read-only value always set to 0.

Assembly number Local slave number Used for connection

1. In this table:
O indicates the originator—or scanner—device
T indicates the target—or adapter—device
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The following property settings have been made in this example:

If you have edited one or more variable names, you can restore the default variable 
names by clicking on the Default Name button.

Setting Description

Input:

Structure 
Name

The read-only name for input structures. By default, it is the concatenation of:
the prefix T_
the alias device name—in this case NOC01
the device number—in this case 01
the suffix _IN

In this case, the default would be T_NOC01_01_IN.

Variable 
Name

The editable base name for input variables. By default, it is the concatenation of:
the alias device name—in this case NOC01
the device number—in this case 01
the suffix _IN

In this case, the default would be NOC01_01_IN.
For this example, accept the default variable name.

Output:

Structure 
Name

The read-only name for output structures. By default, it is the concatenation of:
the prefix T_
the alias device name—in this case NOC01
the device number—in this case 01
the suffix _OUT

In this case, the default would be T_NOC01_01_OUT.

Variable 
Name

The editable base name for output variables. By default, it is the concatenation of:
the alias device name—in this case NOC01
the device number—in this case 01
the suffix _OUT

In this case, the default would be NOC01_01_OUT.
For this example, accept the default variable name.
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Local Slave Inputs and Outputs

Introduction

The Ethernet communication module serves as an adapter when the 
Active Configuration field is set to Enabled in the configuration window 
(see page 95) for one (or more) of the module’s local slave nodes.

When a local slave instance of an Ethernet communication module is enabled, the 
designated memory location allocated to that instance is exposed to, and can be 
accessed by, other devices.

The I/O data exchange, between the remote device and the local slave, is 
configured as part of the remote device’s configuration settings.

Configuring the I/O Items

You can configure input and output items in groups of 1 or more single bits, 8-bit 
bytes, 16-bit words, 32-bit dwords, or 32-bit IEEE floating values. The number of 
items you create depends upon the data type and size of each item.

The process for creating and defining I/O items for the local slave is the same as for 
any adapter class device, and depends upon the type of items you wish to create.

In support of the ongoing configuration example, the following items are required:
4 input word items
1 output word item

NOTE: The items created, below, are designed to hold data received from, or sent 
to, the third-party scanner. In addition to these items, it is necessary to include logic 
in the application programs in which the Ethernet communication module and the 
third-party scanner, respectively, are included. Writing this code is beyond the scope 
of this example.
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Creating Input Word Items

To create input items for local slave 01:

Step Action

1 Select the Input tab to open that page:

NOTE: In this example, each row represents a byte. Because all of the items you 
create will be a 16-bit words, each item consists of 2 rows.

2 In the Default Item Name Root input box type: ProductionTotal_LineA.

3 Starting at the beginning of the table, select the first two rows: 0 and 1:
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4 Click the Define Item(s) button.The Item Name Definition dialog opens:

5 Select WORD as the New Item(s) Data Type, then click OK. A new item is 
created:

6 Click Apply to save the new items, and leave the page open.

7 Repeat steps 2 - 6 for each new word item you need to create. In this example, 
that includes the following items:

Rows 2-3, Default Items Name Root: ProductionTotal_LineB
Rows 4-5: Default Items Name Root: Events_LineA
Rows 6-7: Default Items Name Root: Events_LineB

8 The next task is to create output words.

Step Action
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Creating Output Word Items

To create output items for local slave 01:

Step Action

1 Click on the Output tab to open the following page:

NOTE: In this example, each row represents a byte. Because the only item you will 
create is a 16-bit word, you will select 2 rows.

2 In the Default Item Name Root input box type: DataReceived.

3 Starting at the beginning of the table, select the first 2 rows, 0 and 1:
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4 Click the Define Item(s) button.The Item Name Definition dialog opens:

5 Select WORD as the New Item(s) Data Type, then click OK. A new item is 
created:

6 Click OK to close the Items window.

7 Select File → Save to save your edits. 

Step Action
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Using Local Slave Inputs and Outputs

The inputs and outputs created, above, will be used as follows:
the third-party device will update values of the following variables:

ProductionTotal_LineA
ProductionTotal_LineB
Events_LineA
Events_LineB

the Ethernet communication module will update value of the DataReceived 
variable in the third-party device at the configured RPI.


